Study Guide for Certification Exam
IC3 GS4 Session 3
Living Online
Internet and Computing Core Certification Global Standard 4
The Living Online examination covers skills for working in an Internet or networked environment and
maximizing your communication, education, collaboration and social interaction in a safe and ethical
way.

Instructions:
1. Log into our online classroom at canvas.instructure.com (You should have received an
invitation to the class from me.)
2. Read this study guide
3. Take quizzes (may be repeated)

Helpful Videos on Windows 7
http://windows.microsoft.com/en‐us/windows7/help/getting‐started#T1=tab01
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Exam Objectives
Communication Networks and the Internet
Networks and the Internet turn computers into powerful tools for finding, sharing, and storing
information around the globe. This domain helps you identify network fundamentals and the benefits
and risks of network computing. This includes understanding that different networks transmit different
types of data, the roles of clients and servers in a network, and the fundamental principles of security.
 Identify network fundamentals and the benefits and risks of network computing

Electronic Communication and Collaboration
Email, cell phones, blogs, teleconferencing, social networks, and other electronic communication tools
connect billions of people instantly worldwide. This domain helps you identify various types of electronic
communication and collaboration, how they work, and how to use them effectively. This includes and
understanding of “the rules of the road” for online communication (e.g., “netiquette), and common
problems associated with electronic communication (e.g., delivery failure, junk mail, fraud, viruses, etc.).
 Identify different types of electronic communication/collaboration and how they work
 Identify how to use an electronic mail application
 Identify the appropriate use of different types of communication/collaboration tools and the
“rules of the road” regarding online communication (“netiquette”)

Using the Internet and the World Wide Web
The Internet is not just for entertainment; it has become one of the principle ways of finding and sharing
information, keeping up with friends, doing business, and even dealing with the government. This
domain provides a thorough review and explanation of the Internet and some key, supporting
components such as web sites and effective ways to search for and find information. Also learn how to
evaluate the quality of information found on the Web, and identify responsible and ethical behaviors
when creating or using online content.
 Identity information about the Internet, the World Wide Web and Web sites and be able to use
a Web browsing application
 Understand how content is created, located and evaluated on the World Wide Web

The Impact of Computing and the Internet on Society
Computers are becoming more and more important to every aspect of life, including work, school,
government, home and social interaction. This domain identifies how computers are used in different
areas of life, the risks of using computer hardware and software, and how to use computers and the
Internet safely, ethically and legally.
 Identify how computers are used in different areas of work, school and home
 Identify the risks of using computer hardware and software and how to use computers and the
Internet safely, ethically and legally
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Communication Networks and the Internet
Networks and the Internet turn computers into powerful tools for finding, sharing, and storing
information around the globe. This domain helps you identify network fundamentals and the benefits
and risks of network computing. This includes understanding that different networks transmit different
types of data, the roles of clients and servers in a network, and the fundamental principles of security.

Identify network fundamentals and the benefits and risks of network
computing
Networking Fundamentals
A network is a group of computers that can share information through their interconnections. A network
is made up of the following components:








Computers (often called nodes or hosts)
o Anything connected to a network is called a node (shared printers, computers…)
o Computers connected to a network are also called hosts.
Transmission media‐‐a path for electrical signals between devices
o Network Interface Card (NIC)
o Network cable (often Cat5) or a wireless NIC
Network interfaces‐‐devices that send and receive electrical signals
o Modem (for example a cable modem from Comcast)) to connect to another network
enabled computer (Comcast)
 Old dial up (telephone) modems used POTS (plain old telephone service) at only
56 kps (kilobyte per second)
 A typical cable modem runs at 54mbps—almost 1,000 times faster! What is the
network speed of your computer in the lab?
o Hub: Simple connection point that forwards info to all other connections. (old)
o Router: Manages traffic on the network.
o Switch: Connects additional computers to the router. Better than a Hub.
o Comcast customers use a combination router/modem
Protocols‐‐rules or standards that describe how hosts communicate and exchange data. By
having standards, devices from different manufacturers can communicate. For example,
smartphones, tablets, and PCs using a variety of browsers can all access the same website.

Setting up a Wireless Network
Here’s a video that walks through the process of setting up a home wireless network.
http://www8.hp.com/h20621/video‐gallery/us/en/customer‐care/1251261017001/set‐up‐a‐home‐
wireless‐network/video/#
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Ping
To test if a computer has connectivity with another computer on the same network segment, follow
these steps:





Find out the IP address of the computer you want to ping.
At the Command Prompt enter ping followed by the IP address. You can also ping a website. To
ping my website, enter this at the Command Prompt:
o ping www.mrspeterson220.com
Using the ping command, find out the IP address of Google.com If you enter the IP address in
the Chrome address bar, it should open www.google.com. This will only work for the backbone
companies. www.ibm.com is one. What is the IP address of www.ibm.com?

User IP Address
To find out the IP Address of your computer, enter ipconfig at the Command Prompt, or follow these
steps in Windows:




Control Panel > Network and Internet category >Network and Sharing Center
Click the name of your network listed in “View Your Active Networks”
Click Details

User’s Network Speed
To find your wireless network speed:




Right click the bars in the system tray
Open the Network and Sharing center
Wi‐Fi Status will display speed and duration

Network Protocols
Protocols are the rules used to communicate across a network. The TCP/IP Suite is a set of protocols
that is used on the Internet and on most networks. These include:




HTTP (Hypertext Transfer Protocol): Used to transfer Web pages across the Internet.
HTTPS (Hypertext Transfer Protocol over Secure Socket Layer): Used to securely transmit data
by having it encrypted. This is used in e‐commerce sites.
Transport Protocols: How information is actually sent through various devices on the Internet.
o TCP (Transmission Control Protocol): Used to download files. TCP breaks a file into
packets. Each packet could take a different route to reach its destination—whichever is
the fastest. Once there, the packets are checked and reassembled so the user can see
the complete file. If a packet doesn’t make it to the destination, there is a request for a
new packet. This is why you can’t open a file until it is completely downloaded.
o UDP (User Datagram Protocol): Used to stream videos. As with TCP, the file is divided
into packets. However, if a packet doesn’t reach the destination, it is simply dropped.
This is why you can watch a movie before the entire file is downloaded.
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o

FTP (File Transfer Protocol): Enables users to transfer files between computers. This is
used when a website administrator uploads files to a website. This is used when
uploaded files to GoogleDrive.

Types of Networks
Peer to Peer: (P2P) Each computer can share resources and files with any other computer. An example
of a peer to peer network is Napster. Peer to Peer is not centrally controlled.
Client‐Server: Server provides services to the clients. In our classroom, your computer is a client. The
“P” drive where you save your work is on a File Server. The Printer Server allows each student to share
the same printer. Client‐Server networks are centrally controlled,

Network Sizes
Personal Area Networks (PAN)





Usually cover the small area around a user’s workspace
Allow users to transfer files and gain access to printers and other nearby hardware
Cover a range of up to 10 meters in distance
Used to connect devices a single person uses with their computer

Local Area Networks (LAN)





A private network of computers normally located in the same office or building
Have a high speed and low error rate
Are able to be measured in meters because of their small geographical size
Typically means the computers in the network are within the same building or office

Wide Area Networks (WAN)






Private network of computers spread over a large geographic area
Provide connections between computers in multiple locations,
Cover a significantly larger area than LANs
Can be used to connect different office locations of a large company
Consist of several LANs linked together to create a larger network

Controller Area Networks (CAN)





Are used for real‐time control operations (measure and control temperature, fluids, time, etc.)
Was originally developed for use in vehicles
Has excellent error protection to prevent problems
Sends shorter messages than other networks

Benefits of Networks




Users can communicate, collaborate, share files, and share hardware such as printers.
Less cost since users can share printers
Client/server networks are centrally controlled:
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User logins are authenticated (when you enter your user and password) so users are given
access only to what they have permission to access. For example, in our school teachers
can edit files to the Student Read drive, but students can only view these files.
User files on the server can be backed up
Users can be added or removed
Users can be given rights to different parts of the network
Software updates can be centrally controlled.

Advantages of Networks:















Increased collaboration and communication so several people can work on the same project and
share documents
The ability to allow multiple users to work with the same database files simultaneously
Less expensive software costs. Purchasing a site license for many users is much cheaper than
buying software for each user individually.
Less expensive hardware costs. Many users can share equipment such as printers.
Less expensive maintenance costs. Most software is installed once over the network.
Maintenance and be provided remotely from one central location instead of at the individual
workstation.
More productivity. Most employees will be using the same software and have the same setup,
making it easier to use software and share files.
More security. Network Administrators control user access. When an employee leaves the
company, their access to the network is easily terminated.
Centralized control of hardware and software, reducing costs of installation and maintenance.
Applications are standardized on a network since they’re installed from a central server.
This also providing consistency and more productivity
Online training, video conferences
If the server goes down, users will still be able to access most software such as MS Office and
work on files locally. They would need to log on as “Workstation only.”
Usually there is more room for user files on a network server than at their workstation

Disadvantages of Networks




Users have less autonomy (independence) and privacy
Privacy and Security issues:
o Computer hacked, personal data stolen, identity stolen
Reliance on networks
o If computer goes down due to weather or other circumstance, online data is
inaccessible.
o Vulnerability of data and resources being lost or corrupted by coworker
o Failure of centralized system could stop work for many employees at once

o

Addiction: Instead spending too much time gaming or social networking
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Electronic Communication and Collaboration
Email, cell phones, blogs, teleconferencing, social networks, and other electronic communication tools
connect billions of people instantly worldwide. This domain helps you identify various types of electronic
communication and collaboration, how they work, and how to use them effectively. This includes and
understanding of “the rules of the road” for online communication (e.g., “netiquette), and common
problems associated with electronic communication (e.g., delivery failure, junk mail, fraud, viruses, etc.).
When sending documents that require a signature, use paper mail instead of email. (Although many
programs today provide ways of adding electronic signatures.)

Identify different types of electronic communication/collaboration and
how they work
Synchronous Communication (real time communication)
VoIP (Voice Over IP)



Allows users to make phone calls using the Internet instead of traditional phone service.
T‐Mobile, Comcast, Vonage provide VoIP services.

Video Conferencing




An online face‐to‐face meeting using a WebCam and microphone.
Skype and Google Hangout are examples of Video Conferencing
In April 2013 Microsoft replaced its Instant Messenger service with Skype

Asynchronous Communication
Blog



Post information where it can be read and discussed by others at any time.
Facebook Wall is similar to a Blog

Podcast




Audio files
Radio shows and college lectures
Play on iPod

Microblogging: SMS technology (Short Message Service)






Allows subscriber to broadcast short messages. Twitter and Tumblr are examples.
Two‐way dialog between users who are both online, but users cannot see what each other is
typing while typing. (Instant messaging, chatting) Can you figure out how to chat with fellow
students in our lab?
Quick messages that don’t need to be archived or saved
Commonly used with cell phones (texting).
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MMS (multimedia messaging service)


Allows for the inclusion of video, picture, audio, etc. into the text message. Whenever a picture
message is sent from a mobile phone, this is considered an MMS message.

Forum


A forum is a place where users of a particular product or service may go to ask questions about
the product/service they acquired. Many software companies host online communities (forums)
for their users. http://answers.microsoft.com/en‐us

Identify how to use an electronic mail application
Basic steps to send an email are to click Compose, enter an email address, subject, and message, and
click Send.
















Email Address: mpeterson@barrington220.org means:
o Name of individual: mpeterson
o Name of organization: barrington220
o Type of organization: org (non‐profit)
Recipient: Person(s) in the To: CC: or BC: fields (receiving the email)
Sender: Person in the From: field (sending the email)
TO: Person(s) receiving the email directly. (this email address is visible to all recipients)
CC (Carbon Copy): Person(s) receiving a copy of the email. All these email addresses are visible
to all recipients and the sender
BC (Blind Copy): Person(s) receiving a “blind” copy of the email. (this email address is visible
only to the blind recipient and the sender)
o Tip: To send an email to several people, but show only one name in the To field, place all
the email addresses in the BC field.
o In some programs, this field is labeled BCC (Blind carbon copy)
Reply vs Reply to All
o Reply sends email only to the sender
o Reply to All sends email to the sender as well as everyone in the CC field (but not to
those in the BC field—remember, those are invisible)
Paperclip icon indicates an attachment. Attached files can be previewed, opened, or saved.
When you don’t have the software necessary to open an attachment, Preview (sometimes
called View) can be used instead.
Mailing lists or groups can be saved to send emails to a group of people who share a common
interest.
Sometimes the marks >> are displayed in an email that had been replied to or forwarded.
Email messages listed in the Inbox can be organized in many ways:
o Click a column heading to sort (click the Date heading to sort by date, click the Subject
to sort by subject…)
o Right click a column heading to include another heading or option such as Find.
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Auto Emails (sometimes called “Rules”)
o “Out of Office” can be set up to automatically replay to messages when the user is out
of the office
o “Auto Forward” Rule can be set up to automatically forward certain messages to a
different user, helpful when the user is out of the office.
Computer Use Policy: Document containing rules that must be followed before using a
computer within an organization. The OK button you click on just before entering your user
name and password is BHS’s Computer Use Policy.

Email Benefits






Immediate delivery
Can send to more than one recipient
Keeps a record of previous emails
Easy to search through and organize previous emails
Messages and attachments can be sent, received, and forwarded quickly and inexpensively

Email Security






Messages are encrypted so only intended recipient can open an email
Email on a company or school’s email system is owned by the company or school, and can be access
by a network administrator.
Do not use Company email for personal email
Do not forward chain‐emails. These often carry viruses
Do not open an email from someone you don’t know—again, these often carry viruses

Identify the appropriate use of different types of
communication/collaboration tools and the “rules of the road” regarding
online communication (“netiquette”)
Email Netiquette





Always use correct grammar, punctuation, and spelling in professional emails.
Don’t use Reply to All unless everyone listed needs to receive the reply
Always include a subject in the Subject line.
Never us ALL CAPS—It gives the impression of SCREAMING.
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Using the Internet and the World Wide Web
The Internet is not just for entertainment; it has become one of the principle ways of finding and sharing
information, keeping up with friends, doing business, and even dealing with the government. This
domain provides a thorough review and explanation of the Internet and some key, supporting
components such as web sites and effective ways to search for and find information. Also learn how to
evaluate the quality of information found on the Web, and identify responsible and ethical behaviors
when creating or using online content.

Identify information about the Internet, the World Wide Web and Web
sites and be able to use a Web browsing applications
The Internet







A world‐wide “super network” of computer networks that links computers around the world
Publicly accessed network
Allows interconnected computer networks to transmit data back and forth
Enables contact between companies, individuals, academic institutions, etc.
Consists of approximately 60,000 independent networks and 350 million active users
Is doubling in size each year

History of the Internet and the World Wide Web





The Internet and the World Wide Web have a whole‐to‐part relationship. The Internet is the
large container, and the Web is a part within the container.
On Friday October 29, 1969 at 10:30 p.m., the first Internet message was sent from computer
science professor Leonard KleinRock's laboratory at UCLA.
Robert Kahn and Vinton Cerf created the architecture for the Internet and collaborated on the
design of software – known as the Transmission Control Protocol/Internet Protocol, or TCP/IP.
British physicist Tim Berners‐Lee invented the web at CERN in 1989. The project, which Berners‐
Lee named World Wide Web, was originally conceived and developed to meet the demand for
information sharing between physicists in universities and institutes around the world. He
started W3C.org, which sets the standards for code used in web pages. Sir Tim Berners‐Lee
wants the WWW to be free to everyone.

Website and Internet Terms






Webpage: A document that can be viewed by people navigating the World Wide Web
Website: A group of related webpages
Home Page: A “Home” navigation button of a website displays that website’s home page
Browser: A software application that allows navigation of the World Wide Web
ISP: Internet Service Provider—Maintain and support network connectivity for customers.
o Comcast
o AT&T
o NetZero
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HTML (Hypertext Markup Language): Common computer language used to create web pages.
Plug‐in: A software component that adds a specific feature to an existing software application.
Examples are Adobe Flash Player, Adobe Reader, Real Player, Windows Silverlight, and Java. Be
careful when downloading plug‐ins. Some might be used to hijack your browser, run adware or
spyware, or include unwanted programs or toolbars.
Extension: Similar to a plug‐in, but provided by the same company. For example, Google has
many extensions for GoogleApps; however, to view a pdf file, a user needs the Adobe Reader
plug‐in.
URL: (Uniform Resource Locator): This is the web address of a website. The Domain Name
System (DNS) keeps track of all URLs so no two websites may have the same one. Each URL has
a unique IP address, which is four sets of three digits like this 123.123.123.123. Think of it as a
phone number. Entering the website’s URL into a browser is much easier than entering the
website’s IP address. For example, Google’s IP Address is 74.125.225.114, but it’s much easier
to enter www.google.com
ICANN: The Internet Corporation for Assigned Names and Numbers (ICANN) is responsible for
managing and coordinating the Domain Name System (DNS).

Common Top‐Level Domains
.com
.edu
.gov
.mil
.org

Commercial
College or university
Government
Military
Nonprofit organization

Browser
When choosing a browser, choose one that is has the features you use, is secure, fast, and easy to use.
http://internet‐browser‐review.toptenreviews.com/

Internet Explorer Tips




The House button opens the browser’s home page. The default home page is set in
ToolsInternet Options, General tab, Home Page
The Star button is used to save and access favorite websites. Click the Star, choose Add to
Favorites. Favorites are also called Bookmarks.
The Gear button is used to set your default home page. Click the Gear > Internet Options >
General tab > Home page.
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The Back button displays the previous webpage (Alt + Left Arrow). Hold the Back button to view
history. Ctrl + H also shows history.



Cache: Internet browsers use caching to store HTML web pages by storing a copy of visited
pages and then using that copy to render when you re‐visit that page. If the date on the page is
the same date as the previously stored copy, then the computer uses the one on your hard drive
rather than re‐downloading it from the internet.

Shortcuts








Ctrl + H displays browser history.
o Other ways: Click the Down arrow by the back button or click the Favorites (star) button.
Ctrl + F to Find a word or phrase on the displayed page or document
F5 to Refresh (update) the content of a displayed webpage
Triple click to select a paragraph (usually works)
Shift with arrow to select text
Ctrl + C to Copy selected content
Ctrl + V to Paste

Understand how content is created, located and evaluated on the World
Wide Web
Online Research
When doing research, select key words that describe what you are looking for. Use Boolean logic
operators to have better control in your search.

Evaluating Information





Bias: Is the information on the site slanted towards a particular political or other point of view?
Validity: Can the information be verified by multiple sources?
Relevance: Does the information relate to the topic being researched?
Reliability: Who is the author? Is the author an expert in this area? How current is the
information?
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Operator
AND
OR

Example
Nutrition AND Apples
Apples OR Oranges

NOT
Combo

Oranges NOT color
(Nutrition OR Vitamins) AND Apples

NEAR

Nutrition NEAR Apples

““
Site:

“Red Apples”
“Apple Pie” AND vegan Site: allrecipies.com

Results
Results about both nutrition and apples
All results containing Apples as well as all
results containing Oranges
Oranges, but not the color orange
Results may have Nutrition Or Vitamins, but
must have Apples
Results must have both Nutrition and
Apples, and these words must be near each
other
Exact phrase
Results must be at www.allrecipies.com and
contain “Apple Pie” and Vegan

Google
When using Google, Search Tools allow users to include criteria such as images, image size or how
recently the content was published.
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Use Google’s Advanced Search to narrow down a search even more.
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The Impact of Computing and the Internet on Society
Computers are becoming more and more important to every aspect of life, including work, school,
government, home and social interaction. This domain identifies how computers are used in different
areas of life, the risks of using computer hardware and software, and how to use computers and the
Internet safely, ethically and legally.

Identify how computers are used in different areas of work, school and
home.
Collecting Information


Collecting data. For example:
o Using the Internet to list all the US Presidents and Vice Presidents.
o Using the Internet to find all the cities that have hosted the Olympics.
o Using the Internet to find images of particular plants.

Organizing Information


Organizing data in a logical order. For example:
o Sorting cities alphabetically or by population
o Arranging information into a database or a spreadsheet

Communicating Information


Using one of the many application and collaboration tools to communicate the information.
Here are some examples:
o Social Networking site to share information with a large group of people and allow for
commenting
o Presentation application to communicate information to a class or other audience.
o Collaboration application to communicate with team members working together on a
project.
o Email to send information to specific people.
o Word processing application to communicate information in a written report for class.
o Spreadsheet application to communicate data in the form of a visual graph.

Identify the risks of using computer hardware and software and how to
use computers and the Internet safely, ethically and legally
Computer Health and Safety


Sit correctly at the computer to avoid head and neck injuries as well as hand and wrist injuries.
o OSHA gives these guidelines:
http://www.osha.gov/SLTC/etools/computerworkstations/positions.html
o Microsoft gives these guidelines:
http://www.microsoft.com/hardware/en‐us/support/ergonomic‐comfort
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o

o



Regardless of how good your working posture is, working in the same posture or sitting
still for prolonged periods is not healthy. You should change your working position
frequently throughout the day in the following ways:
 Make small adjustments to your chair or backrest.
 Stretch your fingers, hands, arms, and torso.
 Stand up and walk around for a few minutes periodically.
 Occasionally use your opposite hand to control the mouse. Repetitive motions
are what cause most carpal tunnel injuries.
Follow these keyboarding techniques to type faster and avoid injury:
 Sit straight, like a piano player
 Keep feet flat on the floor
 Keep wrist up (not resting on the keyboard)
 Don’t look at your keyboard
 Elbows should be next to the torso, and bent at a 90 degree angle.
 Sit about an arm’s length away from the monitor.

Eye strain can be caused by watching flickering or quickly moving light patterns on a monitor.

Upright sitting posture. The user's torso and neck
are approximately vertical and in-line, the thighs are
approximately horizontal, and the lower legs are
vertical

Standing posture. The user's legs, torso, neck, and
head are approximately in-line and vertical. The user
may also elevate one foot on a rest while in this
posture.

Ergonomic Keyboards

Split




Curved

Cables should be accessible, but kept off the floor and out of traffic areas.
Don’t overload electrical outlets
o Use an Uninterruptable Power Supply (UPS)
o Use surge protectors

Network Security Terms


SSID (Service Set Identifier) A sequence of characters that uniquely names a wireless local area
network.
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WEP (Wired Equivalent Privacy): A security protocol that is designed for a wireless local area
network by encrypting data transmitted over the WLAN (Wireless Local Area Network). Usually
sufficient for home networks.
WPA (Wi‐Fi Protected Access): An improvement on expected replacement of WEP. WPA
provides more sophisticated data encryption than WEP and also provides user authentication.
Passphrase: A string of characters used for creating a digital signature to prove to a recipient the
identity of the sender. To add a digital signature to a Word document, Go to File > Info >
Permissions. Mark the document as Final. Then, add the digital signature. If the document is
changed, the digital signature will become invalid.

Safe Surfing


HTTPS (Hypertext Transfer Protocol over Secure Socket Layer): Be sure HTTPS is in the address
bar when completing forms that should be secure, such as credit card information, reading
email, checking grades, or modifying account information. To view a certificate, click the Lock in
the address bar, click View Certificates Can you view the certificate on
https://canvas.instructure.com?



Clear Cache: When using a public computer, it’s good to clear temporary files when done
browsing. Internet Options > General to delete browsing history, cookies, saved passwords,
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and temporary Internet files.

Passwords






Change your passwords frequently
Never give out your passwords
Don’t use the same password for everything
Passwords should be at least 8 characters long; and include symbols, numbers, upper case, and
lower case
Passwords should not easily guessed. Don’t use your birthday or names of family members,
friends, or pets

Cookies




Are small files stored on your computer
Saved when a user visits Web sites
Collect information used for:
o customizing Web sites
o collecting demographic information for advertisers
o tracking user preferences
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Bad Cookies





Could be considered an invasion of privacy
Track which Web sites you visit
Track where you go on the Web site
Can be pulled from multiple sources to build a “profile” of your habits
o users may be unaware any of these actions are taking place

Good Cookies




Are useful for customizing advertisements
o prevent young people from being targeted with walkers and the elderly do not end up
with banner ads for skydiving
Identify your home computer when using it to re‐access ecommerce sites.

Other Security Tips













Avoid SPAM (unsolicited emails)
o Avoid posting your email address on unsecured websites
o Install anti‐spam filtering software
Use only secured websites for ecommerce
o Address starts with https:// and has a padlock icon.
o Website is using encrypted communications
Filtering
o Prevent what websites can be viewed
 BHS filters YouTube, Facebook…
o Browser Options: In Internet Explorer, click OptionsContentParental Controls to
restrict access to inappropriate websites.
o Anti‐Spam Filtering Software: Filters Spam emails from entering your email inbox.
Don’t download files from questionable websites—they might contain a virus.
Don’t open attachments from questionable emails—they might contain a virus.
Report cybercrimes to the companies involved and to the Federal Trade Commission at FTC.gov
Protect your personal information (Don’t leave papers around that contain your SS#, birthdate,
address…)
Back up important files (extra copies on flash drive, using backup software, external hard drive,
or online file storage site)
Never log into an ecommerce site from a public computer
o Key logger might be installed to record your user name, password, and credit card
number.

Malware
Malicious software, consists of programming (code, scripts, active content, and other software) that is
designed to disrupt or deny operation, gather information that leads to loss of privacy or exploitation, or
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gain unauthorized access to system resources, or that otherwise exhibits abusive behavior. Malware
includes

Spyware




Is software installed discreetly altering the usability of a computer
Usually installs with other programs, such as file sharing programs
Includes side‐effects such as pop‐up advertisements and crashing of the computer

Keylogger


A program with negative intentions that records information about a user’s browsing
information, e‐mails, instant messages or any other activity performed while using a keyboard

Computer Virus


If your computer is locking up or running slower than usual; has extra, unwanted toolbars or
icons, chances are it has a virus.



Malicious computer program created by a user with objectives to harm or steal another’s
property
o Begins to carry out whatever malicious activity it is supposed to, once it has multiplied
and infected other programs
 the malicious activity is known as the payload
o Can spread fast, slow or not spread at all
o Can remain dormant in a computer until a specified time
o Spread through e‐mail and Internet downloads
o Can alter the normal functions of your computer
o Can delete all data and files on a computer

Computer Worm


An independent program which multiplies itself by copying a segment of itself onto another
computer
o Can contain malicious instructions to hinder a computer’s performance
o Uses flaws or holes in the network to gain access to individual computers
 this gives worms the ability to move extremely fast through a network infecting
computers
 it could possibly infect an entire network of computers within seconds

Trojan Horse


A malicious program disguised inside of another program seemingly beneficial or harmless
o Will generally gain access to administrative areas on a computer
 once it has gained access to these areas, it will create a back door
 this gives the creator of the Trojan horse unauthorized access to the user’s
computer and the information it contains
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o

o

Will sometimes monitor keystrokes and browsing activity
 this information is sent to companies sending the user content and information
they did not request
Can be discreet
 meaning they do not leave any trace of their presence

Copyright Law








Protects owners from having their Intellectual Property copied. Examples of intellectual
property include:
o designs
o concepts
o software
o inventions
o trade secrets
o formulas
o brand names
o art (songs, stories, movies, graphics…)
Protect an author’s original work
o automatically held when a work is created
o denoted by the symbol © (but symbol is not required)
o Professional productions: 95 years from publication or 120 years from creation,
whichever is shorter
o Individual productions: protected for life of author plus 70 years after authors death
o Unauthorized copying is prohibited in most cases
o Fines for using copyrighted material can be higher than $150,000
Copyright‐free (public domain):
o Content from these websites is copyright free, however siting is still advised
 Any .gov site
 NASA (National Aeronautics and Space Administration
 NOAA National Oceanic and Atmospheric Administration
 FWS U.S. Fish and Wildlife Service
 Smithsonian www.si.edu
o Usually 10% or less of the original work is copyright free, but permission and proper
siting is still advised.
Fair Use
o Copyrighted materials (text, pictures, movies, songs…) may be used without paying
royalties for purposes of research, criticism, comment, news reporting, and teaching
under the name of fair use.
 Research papers
 Include a citation to give credit to the owner
 Provide enough information for someone else to find the same text or picture
 Do not change the meaning of the material
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o If a school project is published online, it no longer falls under Fair Use
Intellectual property can also be protected through other legal measures such as trademarks,
patents, End User License Agreements (EULA).

Cybercrime



Any crime involving computers
By connecting to the Internet, a user will:
o Risk losing autonomy and privacy
o Risk access to confidential data by unauthorized people

Pirating


The illegal stealing, copying or exchanging of media including:
o software
o movies
o music

Predators


Take advantage of children by:
o using instant messaging, e‐mail and social network sites
o gaining victims trust and engaging in sexually explicit conversations
o trying to arrange face‐to‐face meetings

Hacker


A computer user with malicious intentions that attempts to gain access to another user’s
computer and information through deceptive methods.

Identity Theft





Is when someone steals your personal information to commit fraud or other crimes including:
o your name
o credit card information
o Social Security number
Nine million Americans have their
identities stolen each year

Phishing







Involves e‐mails pretending to originate from banks or online retailers such as eBay ® or PayPal ®
Looks very similar to an actual e‐mail originating from retailer or bank.
Some look like ligitimate job applications.
Links to a form for victims to enter sensitive information such as user names and passwords.
Victim might also receive malicious viruses or spyware.
If you receive an email claiming that you need to log into your account, never click on the link.
Instead browse to your bank (or whomever the email is claiming to be from) and log in there.
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 Report the email to your bank and to the Federal Trade Commission.
Sample phishing email:

http://www.microsoft.com/security/online‐privacy/phishing‐symptoms.aspx

Tips to Avoid Cybercrime
Install Internet Security Software







anti‐virus, anti‐adware, anti‐spyware, anti‐spam)
implement an Internet firewall, a buffer between your computer and the Internet
install security updates
Best source for detailed technical information about viruses and solutions is the manufacturer of
your anti‐virus software.
Purchase only software that comes with a EULA (End Users License Agreement)
Register your software

Cyberbullying



Is Internet harassment
Tips for dealing with a cyberbully:
o take a break to reduce tension and calm down
o cut off all communication with the cyberbully
o tell an adult
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Cyberbullying Legal Terms








Cyberbullying: The use of cell phones, instant messaging, e‐mail, chat rooms or social
networking sites such as Facebook and Twitter to harass, threaten or intimidate someone.
Defamation: Any intentional false communication, either written or spoken, that harms a
person's reputation; decreases the respect, regard, or confidence in which a person is held; or
induces disparaging, hostile, or disagreeable opinions or feelings against a person.
Libeling: A false publication, as in writing, print, signs, or pictures, that damages a person's
reputation
Slander: Making a false spoken statement damaging to a person's reputation.
Flaming: Attacking someone verbally online. Flaming entails insults, bigotry, name‐calling, or
any outright hostility directed at a specific person.
Spamming: Sending a message indiscriminately to multiple mailing lists, individuals, or
newsgroups.

26

